
USPS® requires that Informed Delivery campaigns include  

full color interactive content that accompanies the scanned  

mailpiece or Representative Image (see page 2). When  

users select the Ride-along Image, visible in a daily digest  

email or on the dashboard, they are redirected to

the target URL.

This supplemental content is meant to enhance the  

customer call-to-action and reinforce the business objective  

of the mailpiece. For optimal quality within the digital setting,  

follow the recommendations and requirements below:

• Sync the look of the Ride-along Image to the mailpiece  
or Representative Image presented.

• Treat the Ride-along Image like a branded, clickable  
button with a call-to-action.

• Opt for a clean, simple layout.

• Provide a direct URL related to the desired useraction.

• Size to at least one maximum dimension: 300px width 
or 200px height.

200px

300px

Reverse type on solid color is  
clean and legible

Look and  
message  
sync to  
mailpiece

Logo  
reinforces  
brand

Call-to-action  
is clear and  
compelling

Lacks customized branding

Try to avoid:

Logo only Image only

Unclear that content is clickable No call to action

Required:

• Save file as a JPEG (.jpg)

• File cannot exceed 200KB in size

• Image color code must be RGB (not CMYK)
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Ride-along Image
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USPS® allows you to enhance your Informed Delivery  

campaign with a full color image that displays in place of  

the scanned mailpiece (i.e., letters and postcards). Users  

can view this content in a daily digest email or on their  

dashboard.

Don’t miss an opportunity to use the production art created  

for your mail campaign. For optimal quality within the digital 

setting, follow the below recommendations and  

requirements.

Try to avoid:

Required:

• Save file as a JPEG (.jpg)

• File cannot exceed 200KB in size

• Image color code must be RGB (not CMYK)
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Representative Image

Ride-along Image

FROM RetailerName

“Retailer Name” is not an actual company and is for illustrative purposes only.

Learn More

Representative Image

• Use a color image of the mailpiece so users correlate 
the digital image.

Note: The image must be branded and directly related to the 

mailpiece and its contents.

• Sync the look of the Representative and Ride-along 
Images to each other for a cohesive experience.

• Size to at least one maximum dimension: 780px width  
or 500px height.

500px  
max  
height

780px max width

Look and feel match  
the Ride-along Image

Use at least one
maximum image
parameter

Color image of the mailpiece

Correlation to mailpiece is lost Lacks customized branding

Lacks mailpiece details Grayscale

9.2018



USPS® requires you to conduct an Informed Delivery  

campaign using a full color image in lieu of your mailpiece

(i.e., catalogs and magazines). Users can view this content in  

a daily digest email or on their dashboard.

Don’t miss an opportunity to use the cover art created

for your latest mailing in a digital preview of incoming mail.  

For optimal quality within the digital setting:

Try to avoid:

Required:

• Save file as a JPEG (.jpg)

• File cannot exceed 200KB in size

• Image color code must be RGB (not CMYK)
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Representative Image - Flats

Ride-along Image

FROM RetailerName

“Retailer Name” is not an actual company and is for illustrative purposes only.

Learn More

Representative Image

• Use a color image of the mailpiece so users correlate 
the digital image.

Note: The image must be branded and directly related to the 

mailpiece and its contents.

• Sync the look of the Representative and Ride-along 
Images to each other for a cohesive experience.

• Size to at least one maximum dimension: 780px width  
or 500px height.

500px  
max  
height

780px max width

Look and feel match  
the Ride-along Image

Use at least one
maximum image
parameter

Color image of the mailpiece

Correlation to mailpiece is lost Lacks brand colors

9.2018

Lacks mailpiece details Grayscale
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Need Help?
Verifying Image Dimensions

To determine whether a Ride-along or Representative Image meets the size requirements, follow the steps below.

1. Make a copy: Create a copy of your image file so you do not lose the original.

2. Open image in Paint: Right click on the image file, select “Open with,” and select “Paint” from the options provided.

3. Select the entire image: Select the entire image by pressing CTRL + A or by clicking the “Select” button in the 

Home tab and choosing “Select all.” You will see a dashed line appear around the edge of the image. 

4. Click the “Resize” button: You can find the “Resize” button in the Home tab or by pressing CTRL + W. This will 

open the “Resize and Skew” window.

5. Verify image dimensions: Select “Pixels” next to the By field. The image dimensions should appear. Horizontal 

corresponds to width and vertical corresponds to height.

Ride-along Image:
Horizontal cannot exceed 300px

Representative Image:
Horizontal cannot exceed 780px

Ride-along Image:
Vertical cannot exceed 200px

Representative Image:
Vertical cannot exceed 500px

Does your image exceed 
size requirements? 

Follow the steps on the 
next page to learn how to 
resize your images…
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Need Help?
Resizing Images - Option 1

To resize a Ride-along or Representative Image that does not meet the size requirements, follow the steps below. 

Steps 1-4 are the same as the “Verifying Image Dimensions” steps.

1. Make a copy: Create a copy of your image file so you do not lose the original.

2. Open image in Paint: Right click on the image file, select “Open with,” and select “Paint” from the options provided.

3. Select the entire image: Select the entire image by pressing CTRL + A or by clicking the “Select” button in the 

Home tab and choosing “Select all.” You’ll see a dashed line appear around the edge of the image. 

4. Click the “Resize” button: You can find the “Resize” button in the Home tab or by pressing CTRL + W. This will 

open the “Resize and Skew” window.

5. Use the “Resize” fields to change the size of the image: Change the size by typing in the new pixel size (values) 

desired. Important Note: Making an image larger than the original will result in a lower-quality picture. Leaving the 

“Maintain aspect ratio” option selected ensures the image is not distorted.

6. Click “OK” to see your resized image: The image will be resized according to the values you entered. 

7. Remove the excess canvas: The image will be resized, but the white canvas it is on will stay the original size.

• Click and drag the edges of the canvas to resize it (see below), which removes the excess white space.

• Or, use the “Crop” function in the Home tab to remove the extra canvas. Press CTRL + A to select the entire 

image to start. Then, select “Crop,” click and drag to highlight only the area around the resized image, and select 

“Crop” again. The excess white space should disappear and the canvas should match the resized image. 

8. Save the resized image: Once the image is resized (and you confirm the size requirements are met), save the file. 

Select “Save As” from the File tab and choose “JPEG picture.” Then, name the file and choose where you want to 

save it. 

Type in the new pixel size that is 
within the size requirements 
for the Ride-along or 
Representative Image.

“Maintain aspect ratio” 
ensures the image is not 
distorted when resizing.
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Need Help?
Resizing Images - Option 2

To resize a Ride-along or Representative Image that does not meet the size requirements, follow the steps below. 

Steps 1-4 are the same as the “Verifying Image Dimensions” steps.

1. Make a copy: Create a copy of your image file so you do not lose the original.

2. Visit an image resizing website: Search “resize jpeg” to find a variety of websites that will help you resize images 

for free. 

3. Upload the JPEG file you want to resize: Select and upload the file you want to resize. 

4. Use the resizing controls to change the size of the image: Each website has a different set of controls to adjust 

the image size. Options include clicking and dragging a box, using sliders to adjust the size, or entering the exact 

pixel dimensions. When possible, enter the exact pixel dimensions desired and click “Save” or “Resize image.” 

Important Note: Making an image larger than the original will result in a lower-quality picture. To avoid losing quality, 

maintain the aspect ratio. 

5. Download the resized image: Once you resize your image, save the changes to the file. Select “Save As” and 

choose “JPEG picture.” Then name the file and choose where to save it.
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Need Help?
Tips to Determine Color Code

To determine the color code of a Ride-along or Representative Image, follow the steps below. 

1. Make a copy: Create a copy of your image file so you do not lose the original.

2. Convert the image to a PDF: Locate the image file on your computer and right click on the file. Select the “Convert 

to PDF” option.

3. Navigate to Print Production: Locate the tool bar that lists “Home,” “Tools,” and “Document.” Select “Tools” and 

scroll until you find “Print Production.” Select this option. Important Note: The location of the “Print Production” option 

may differ depending on the application you are using.

4. Verify color code: Identify and select “Output Preview” from the menu. On the pop-up menu that appears, under the 

“Show” drop down, select RGB. If the image contains CMYK (Cyan Magenta Yellow Black) elements, these 

elements will disappear from the image. If there are no CMYK elements, there will be no change to the image.

5. (Optional) Reformat image: If the image contains CMYK elements, the image owner will need to convert the color 

code to RGB before the image can be used for an interactive campaign. Official image editing software may be 

required to convert color code.

Don’t see a change after selecting “RGB”? 
This means that your image is in the required 
color code and does not need to be reformatted.
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Legal Terms
CUSTOMER/SUBMITTER OBLIGATIONS REGARDING INTERACTIVE CONTENT AND IMAGES

By submitting Content to USPS in connection with any Informed Delivery campaign, you agree to the terms and conditions specified below  

and to faithfully comply with all other rules, regulations, technical specifications, and requirements for Informed Delivery campaigns. “Con-

tent” as used herein includes supplemental content (e.g., Ride-along images, Representative images, interactive links, and text or any other  

content) that you provide to USPS by any means whatsoever (including but not limited to email, upload through PostalOne!, the Informed  

Delivery Mailer Campaign Portal, or otherwise), other than the physical mailpiece and any USPS-generated grayscale image thereof.

Your Representations and Warranties

You represent and warrant that you have all necessary third party rights, and hereby grant to USPS such rights, to use, display, publish, trans-

mit, distribute, and make copies of the Content, and otherwise use it in your Informed Delivery campaign, without infringing any rights of any  

third party or violating any applicable laws, rules or regulations. This grant includes the rights covering the ordinary use to which recipients put  

the Content. The rights referred to in the foregoing include, without limitation, copyrights, trademark rights, rights of publicity (name and like-

ness rights) and any other rights necessary to use the Content. You further represent and warrant that the nature, appearance, and display of  

the Content is consistent with the mailability requirements of the Domestic Mail Manual.

Eligible Content must not: (1) be defamatory, indecent or obscene; (2) depict violent or sexual material and/or material that would be harmful  

to minors; (3) violate any applicable law, statute, ordinance or regulation, or be legally actionable; (4) claim or create the impression, whether  

expressly or by implication, that the Postal Service endorses you or your product, service or offering; or (5) promote alcohol, tobacco, weap-

ons, or gambling. You acknowledge and agree that USPS will not be involved in any way with the design of the Content. You agree to eval-

uate and bear all risks associated with the use of any Content. You are solely responsible for and assume all liability arising from use of the  

Content in or through or otherwise as a result of your Informed Delivery campaign. You agree that the fact that USPS reproduces, displays,  

or distributes the Content and/or otherwise uses it in the Informed Delivery campaign: (1) does not constitute approval or endorsement of the  

Content; (2) does not indicate that the Content complies with any or all applicable laws, including Postal law or regulations, or (3) does not  

constitute acceptance of any liability or risk arising from the Content. In the event that the Content contains an interactive link, you warrant  

and represent that any web page linked to directly from Informed Delivery, whether through an email or through the Informed Delivery inter-

face, shall not take Informed Delivery users to a web page that could be confused by a reasonable person to be a Postal Service web page.

Indemnity

You agree to indemnify and hold the Postal Service and its Governors, officers, employees, agents, printers, contractors, vendors, and suppli-

ers harmless against any and all expenses and losses of any kind (including attorneys’ fees and costs) incurred in connection with any claims  

of any kind arising out of breach of any of the above representations and warranties, and publication, transmission, display or distribution of  

the Content (including, without limitation, any claim of patent, trademark or copyright infringement, libel, defamation, breach of confidentiality,  

misappropriation of trade secret, invasion of the rights of privacy or publicity (including the right to control use of one’s name and likeness),  

false or deceptive advertising or sales practices) or any material or products of your’ s to which third parties can link through the Content.

Disclaimer

THE PRODUCTS, SERVICES, WEBSITE, CONTENT AND/OR MATERIALS AVAILABLE THROUGH USPS ARE PROVIDED ON AN "AS IS"  

AND "AS AVAILABLE" BASIS AND WITHOUT WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED.

USPS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTY OF MER-

CHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, ARISING FROM A COURSE OF DEALING OR PERFORMANCE, NONINFRIN-

FGEMENT, OR TRADE USAGE. USPS SHALL NOT BE LIABLE TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY LOSS, COST,  

DAMAGE OR EXPENSE, INCLUDING WITHOUT LIMITATION LOSS OF PROFITS, ARISING OUT OF OR IN CONNECTION WITH ANY  

CONTENT INCLUDED IN INFORMED DELIVERY, THE MANNER IN WHICH ANY CONTENT IS DISPLAYED OR DISTRIBUTED, THE FAIL-

URE TO DISPLAY ANY CONTENT, OR ANY TECHNICAL MALFUNCTION, COMPUTER ERROR OR LOSS OF DATA OR OTHER INJURY,  

ARISING, DIRECTLY OR INDIRECTLY, FROM YOUR USE OF THE INFORMED DELIVERY FEATURE. SPECIFICALLY, AND WITHOUT  

LIMITING THE FOREGOING, USPS DOES NOT REPRESENT OR WARRANT THAT ANY CONTENT WILL BE DISPLAYED OR OTHER-

WISE TRANSMITTED OR DISSEMINATED THROUGH INFORMED DELIVERY WITHOUT INTERRUPTION ORERROR.

Limitation of Liability

IN NO EVENT SHALL USPS BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR EXEMPLARY DAMAGES,  

EVEN IF SUCH DAMAGES ARE FORSEEABLE, AND REGARDLESS OF WHETHER USPS HAS BEEN ADVISED OF THE POSSIBILITY  

OF SUCH DAMAGES. YOUR SOLE AND EXCLUSIVE REMEDY FOR ANY CLAIM ARISING FROM OR RELATING TO YOUR PARTICI-

PATION IN AN INFORMED DELIVERY CAMPAIGN SHALL BE LIMITED TO A MAKE-GOOD PLACEMENT OF THE CONTENT AT A LATER  

TIME IN CONNECTION WITH A SUBSEQUENT MAILING.


